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Overview of the 
Research module

The Research module in Advisor Workstation has a number of tools to assist you in 
selecting investments for your clients. You can search for investments by name, ticker, or by 
defining criteria for a search. You can save a list of investments, create a custom view of 
datapoints you choose, and generate a number of graphs and reports.

In addition, efficient use of the Research module saves you time in other areas of Advisor 
Workstation, particularly when creating portfolios or hypothetical illustrations.

What you will learn 
in this section

In this section, you will learn how to do the following with the Research module  
in Advisor Workstation:

• Understanding the layout of the Research module
• Find an individual security
• Find a list of investments by name or ticker
• Conduct a search by criteria
• Navigate through the Research module
• Create and manage lists of investments
• Create custom views
• Set a default view
• Create reports, and 
• Generate graphs.
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What data is available in the Research module?
What data is available 
in the Research module?

The data universes (Stocks, Mutual Funds, ETFs, etc.) available to you in the Research 
module depend on those licensed by your institution. The universes your institution 
susbscribes to are shown in the left-hand navigation pane.

In addition to the different security universes, you will also find the following items in 
the Research module:

Note the data universes 
available under 
the Research module

Item Description

All Securities Universe

This universe shows you all security types available to 
you, at once. This allows you to compare, say, mutual 
funds to ETFs and stocks, without having to switch back 
and forth between each universe. 

Benchmark Universe

This universe shows you almost 38,000 global indexes 
you can use to create custom benchmarks. Be sure to 
note which indexes have both return and composition 
data available, as these will be more meaningful when 
comparing to a client’s portfolio. 

Research Lists
Here you can see any list you have saved from any 
universe in the Research module. Each user can save up 
to 100 lists, with up to 100 items per list.

Research Searches

Here you can see any search by criteria you have saved in 
the Research module. Each user can save up to 100 
searches. No limit exists on the number of criteria you can 
use in each search.

Research Custom Views
This universe shows you all of custom views you have 
created. Each user can save up to 100 custom views, 
with as many as 100 columns in each custom view.

Alerts
These will be alerts you have created for securities, rather 
than those you have created for client portfolios.
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How often are the 
returns for each 
database updated?

The following table details the frequency with which each investment type is updated 
in Advisor Workstation:

 In addition to the daily NAV update, holdings/composition information for many mutual funds  
is updated on a monthly basis. The remaining mutual funds are updated quarterly. 

The price of this investment type… Is updated at this rate…

Mutual funds NAVs updated daily

Stocks Current, with 20-minute delay.

Variable Annuities/Universal Life AUVs updated at month end

Exchange-Traded funds Current, with 20-minute delay

Closed-End funds Current, with 20-minute delay
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Understanding the Layout of the Research Module

OverviewThis section will orient you to the Research module’s interface, and how you can best 
navigate through it. Mastering these basic concepts will assist you in making the most 
efficient use of the Research module, and speed your learning of the entire Advisor 
Workstation 2.0 application, since the knowledge you gain here can be applied to other 
areas of the application that also use a spreadsheet interface.

You will learn the following:

• How to access the Research module, and
• What are the different parts of the screen.

How do I access the 
Research module?

You can access the research module one of two ways:

• At the top of the Advisor Workstation 2.0 window, click once on the Research tab. 
This will take  you directly to the US Mutual Fund universe.

• In the left-hand navigation pane, click once on the universe or area (Research Lists, 
Research Searches. etc.) you’d like to move to directly.

Click on this tab to access
the Research module 

You can also click the 
name of an item in this
list to move to that area
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What are the different 
parts of the Research 
module?

Note the screenshot and table below for details on the different parts of the Research 
module. Certain features, such as custom views and working with saved searches and 
lists are discussed in greater detail later in this manual. 

Letter Name Description

A Universe selection drop-down field

This field allows you to choose the investment universe (mutual funds, 
stocks, etc.) you want to see in the spreadsheet area. If the left-hand 
navigation area is collapsed, as shown in the screenshot above, this field 
allows you to see other parts of the Research module without having to 
expand the lefthand navigation pane.

B View drop-down field This field allows you to select a pre-built view, or one you created.

C Find field This field allows you to look for items by name or ticker.

D Saved Searches and Lists drop-down field This field shows you the lists and searches saved for a specific universe.

E Benchmark row
This row displays data (where appropriate) for the index you select for the 
spreadsheet area.

F Spreadsheet area The main area of the screen, containing the rows and columns of data.

G Vertical scroll bar Allows you to scroll up and down through the rows displayed on a page.

H Page selector and Page icons
Shows you which page you are on among the items in a univere. The Page 
Next/Previous Page icons move you one page at a time, or you can type in 
a page number to go to, or move to the last page or first page in a set.

I Horizontal scroll bar Allows you to scroll left or right, in order to see additional columns.

A B C D

E

H

F

 I

G
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Managing the Spreadsheet Area Overview
Managing the Spreadsheet Area

OverviewThis section will show you how to make the best use of the spreadsheet area in the 
Research module. You will learn how to do the following:

• Change universes displayed in the spreadsheet 
• Update the benchmark being used in the spreadsheet 
• Resize columns in the spreadsheet
• Sort the columns in the spreadsheet
• Use the drag-and-drop feature for creating a custom view
• Lock the columns in a spreadsheet
• Change the number of rows being shown in a spreadsheet, and
• Scroll through the pages in a spreadsheet.

How do I change the 
data universe I see in 
the spreadsheet?

You can change the information you see in the spreadsheet area one of two ways:

• Click the name of the area you want to go to in the left-hand navigation pane, or
• Use the universe selection drop-down field on the toolbar.

You have two options 
when it comes to 
navigating to different parts 
of the Research module
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How do I update the 
benchmark being used 
in the spreadsheet?

The first row for each data universe is the benchmark for that universe. Each data 
universe has its own benchmark. You can change the benchmark to use a different 
index, a Morningstar Category, or another security from the data universe. This can be 
particularly useful after you have run a Search by Criteria to find a specific set of 
investments. 

To change the benchmark for a data universe, do the following:

1. From the View menu, select Change Benchmark. The Change Benchmark dialog box 
appears.

2. From the Select Universe drop-down field, choose an option for the search. If you want 
to use an index, you can leave Benchmark universe selected.

3. In the search field, type a portion of the item’s name you want to use. You do not need 
to type the item’s full name, but if you type fewer than four letters, the system will look 
only for items that begin with the text string you entered. To find items that contain (but 
do not necessarily begin with) the search string, be sure to enter at least four letters.

4. Click the Find button. The results matching your search will appear in the Total Search 
Results area.

5. If an item already appears in the Benchmark Selected for Universe area, click once to 
highlight the item, then click Remove.

6. Scroll through the set of results and click once to select the item you want to use.
7. Click the Add button. The item should now appear in the Benchmark Selected for 

Universe area.
8. Click OK to close the dialog box. The new benchmark is applied automatically.

Select this item 
from the View menu

Type the name of 
the benchmark you 
want to find here
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Managing the Spreadsheet Area How do I resize the columns in the spreadsheet?
How do I resize the 
columns in the 
spreadsheet?

You can make the columns in a spreadsheet wider or more narrow, in order to make it 
easier to see the data in a column, or to fit more of them onto the screen. The changes 
you make to a column’s width cannot be saved and will be reset once you refresh the 
screen. For example, if you change the width of columns in the US Mutual Fund 
universe, then move to the US ETF universe and back to the US Mutual Fund universe, 
the columns will revert to their default width.

To change the width of columns in a spreadsheet, do the following:

1. Move your mouse cursor over the border between two columns. It will change to a two-
headed arrow.

2. Left-click and drag the column until it is the width you want, then release the left mouse 
button.

When the cursor changes 
to this icon, you can click 
and drag to resize the column

Note the new width of the 
Name column in this screen shot 
compared to the one above
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How do I sort the 
columns in the 
spreadsheet?

Note the following rules that apply to sorting items in any spreadsheet view:

• You can sort items in ascending order by clicking once on a column’s header name. 
• Clicking the header name a second time will sort the column in descending order. 
• You can also sort by clicking the drop-down arrow in a column’s header name and 

selecting either Sort Ascending, or Sort Descending.
• You can sort on only one column at a time.
• You can determine which column is controlling the sort order by noting which column 

header is highlighted, and the arrow icon to the right of the column’s name.

How do I use the drag-
and-drop feature for the 
columns in the 
spreadsheet?

You can create a custom view by dragging and dropping columns in place. Note the 
following about this feature:

• You can work only with the columns that are presently showing on the screen; there is 
no way to incorporate columns from other views. 

• The changes are only temporary; the view will reset to its default arrangement once 
the screen is refreshed, such as when you go to another view, or click on a different 
module in Advisor Workstation.

• You can save the rearranged columns as a custom view by going to the menu bar and 
selecting View…Save as Custom View. 

To use this feature, do the following:

1. Move your mouse cursor over a column’s header name.
2. Left-click and drag the column left or right. 
3. Release the left mouse button when the column is positioned where you want it.

Note how the 
Morningstar Category column 
is highlighted, and has the 
arrow icon to the right of its name

Note the icons pointing 
to the new location for 
the Morningstar Rating 
column as it is dragged 
to the left and dropped
in a new location
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How do I lock columns 
in the spreadsheet?

You can lock columns in place, to keep them from moving as you scroll to the right. 
(This is similar to freezing a worksheet in Microsoft Excel.) The Name column is locked 
by default. You can lock columns one of two ways:

• Click the drop-down arrow in a column’s header and select Lock. This automatically 
moves the column to the locked area at the left side of the spreadsheet. You can use 
the same method to unlock a column.

• Drag-and-drop a column to the left of the locked area (on the left side of the 
spreadsheet). The locked area of the spreadsheet is denoted by a solid vertical line.

Click the drop-down 
arrow in the column 
header and select Lock 
to freeze a column in place

The solid vertical line marks 
marks the locked area
Drag-and-drop a column 
to the left of this area 
to automatically lock it in place
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How do I change the 
number of rows in the 
spreadsheet area? 

By default, each spreadsheet displays up to 25 rows at once, but you can elect to 
display up to 100 rows at once. 

To change the number of rows being displyed in a spreadsheet, do the following:

1. From the File menu, select Preferences. The Preferences dialog box appears.

2. Under Spreadsheets, click Spreadsheet Views.
3. Click the Results per Page drop-down field.
4. Select the number of rows you would like to see at once. 

5. Click Save to save your changes. 

 If you were previously using the Morningstar Preference set, you will be prompted to create a 
new set of preferences. Click New or Save As to create a custom set of preferences.

From the File menu, 
select Preferences

Select the number of rows 
you would like to see on 
each spreadsheet page
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Managing the Spreadsheet Area How do I scroll through the pages in a spreadsheet?
How do I scroll through 
the pages in a 
spreadsheet?

Depending on the number of items being displayed in a spreadsheet and the number of 
items your Preferences are set to display, you can scroll vertically to see additional 
items in a spreadsheet. But at most you will be able to see 100 items on any one page. 

To scroll further through a list of items in a spreadsheet, use the page arrow icons at 
the bottom-left corner of the screen. The four arrow icons allow you to move forward or 
backward one page at a time, or all the way to the end, or all the way back to the 
beginning.

Use these icons 
to scroll through the 
pages in a spreadsheet
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Finding Investments in the Research Module

OverviewThis section shows you two ways to search for investments in Advisor Workstation:

• using the Find field on the toolbar, and
• Running a Search by Criteria.

 A third method is available, but it involves building a list and is discussed in the next main 
section, beginning on page 24.

What are the rules for 
finding investments by 
name or ticker symbol?

You can find investments by name or ticker using the Find field on the toolbar. Note the 
following rules when using this feature:

• Unless you are in the All Securities universe, you can search by only one universe 
(Mutual Fund, ETF, Stock, etc.) at a time. Select the universe you want to search on 
first, then enter your search string.

• You do not need to enter the complete name of an item. For instance, to find all mutual 
funds that begin with “Fidelity,” you can simply type Fid. 

• If you know only a portion of a security’s name - and you aren’t sure about the 
beginning portion of the name - be sure to enter at least four characters. That triggers 
the system to use not only a “name begins with” methodoloogy when searching, but 
also a “name contains” methodology.

 Note: Separating items with a comma (agthx,contrafund) uses an OR methodology: find 
agthx OR contrafund. Separating items with a space (muni ca) uses an AND methodology: 
find funds that have both “muni” and “ca” in the name.

• You can enter up to 100 characters at once in the Find field.
• You cannot enter part of a ticker symbol, as you can with a name. Each ticker symbol 

you enter must be complete and accurate. Partial ticker symbols will not have a record 
returned. 
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How do I use the Find 
field?

To use the Find field, do the following:

1. On the toolbar, click in the Find field.
2. Type in your search string.

3. Press <ENTER>, or click the Go button. The results are displayed in the main 
spreadsheet area. 

 Note: The breadcrumb trail above the spreadsheet area will update to reflect your search.

How do I reset the 
Research module after a 
search?

Once you use the Find field, the breadcrumb trail below the toolbar reflects the search 
filter. If you return to the Find field and enter a new search string, you will be searching 
within this filter. After running a search, you can reset the spreadsheet view to show all 
items by doing one of the following:

• In the breadcrumb trail, click the name of the universe that preceeds the name of 
the  search. 

• At the bottom of the screen, click the Reset Universe icon.

Enter your 
search string here

Click the name of 
the universe to 
reset the spreadsheet

A second option is
to click this icon
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How do I create a 
search with the 
Screener tool?

The Screener tool is available in the following Research Module universes: Mutual 
Funds, ETFs and Stocks. The Screener tool allows you to search for securities based on 
pre-defined criteria. The criteria available to you in the Screener tool will vary based on 
the universe you are in.

When using multiple criteria in a search, all of them work together to filter the result set 
in the grid view. The default selection for each criterion is No Preference. If you select 
certain categories and later want to remove all of them, note that you can simply check 
the No Preference box again.

The Screener panel itself can be both hidden, and collapsed. To display the Screener 
tool, click the Show Screener icon. You can begin to build your search by selecting 
options from the criteria available.

To collapse the Screener panel, click the double-arrow icon at the top of the panel. To 
hide it altogether, click the Hide Screener icon.

The Screener panel immediately appears on the left side of the screen. You can begin 
to build your search by selecting options from the criteria available. 

Click here to open
the Sreener tool

Click either of these places
to hide the Screener tool
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Finding Investments in the Research Module How do I save a Screener search?
The default selection is No Preference. If you select certain criteria and later want to 
remove all of them, note that you can simply check the No Preference box again. 

How do I save a 
Screener search?

You can save the searches you create in the Screener tool, and retrieve them later from 
the same area, or by using the Advanced Search dialog box or the Research Searches 
page. To save a search within Screener, do the following:

1. Click Save at the top of the Screener panel.

Check this box to clear your selections

Click here to save the search
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Finding Investments in the Research Module How do I create an advanced search?
2. In the dialog box that appears, type a name for the search.

 Note: This dialog box shows searches created either in the Screener panel, or in the 
Advanced Search dialog box. 

3. Click OK to close the dialog box.

Searches created and saved in the Screener tool can be accessed from the Research 
Searches page or opened in the Advanced Search dialog box.

How do I create an 
advanced search?

Beyond just the ticker symbol or an investment’s name, one of the most powerful 
features of Advisor Workstation’s Research module is its ability to sort and search 
based on hundreds of data fields per investment universe using the Advanced Search 
dialog box. Further, you can save up to 50 searches using this tool.

To create a search using custom criteria, do the following:

1. From the menu bar, select Tools…Advanced Search. The Advanced Search  
dialog box appears.

2. Select an item from the Field Name column. The list of options available from this drop-
down field can be scrolled through By View (the default setting) or Alphabetically. The 
views presented here match the system views available in the spreadsheet area.

 You can change between By View or Alphabetically by selecting the appropriate option button 
in the View Field Name area.

Type a name for the search here

Select this option 
from the Tools menu
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Finding Investments in the Research Module How do I create an advanced search?
3. From the Operator column, select an option. The default value is =. 

 Only options that make logical sense based on your selection from the Field Name column 
will be available here. For example, if you select Morningstar Category as the Field Name, 
you cannot use < or > as the Operator.

4. From the Value column, make a selection from the options provided, or enter a value of 
your own.

Select this option to 
find criteria alphabetically
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Finding Investments in the Research Module Performing complex searches with the Advanced Search dialog box
5. Repeat steps 2-4 for all additional criteria you wish to add. Note that for these additional 
lines, you must make a selection from the Relationship column. The options here are 
explained in the following table.

 If you click in the Field Name field for a subsequent row, the Relationship column defaults to 
the value of the previous row. For the second row, the Relationship column defaults to AND.

6. To see the number of records returned by your criteria, click Run Search. You can then 
modify your criteria to expand or narrow the number of items returned.

7. To see the results of your search displayed in the spreadsheet area, click OK.

Performing complex 
searches with the 
Advanced Search  
dialog box

A complex search employs both the OR as well as the AND relationship between its 
criteria, effectively combining multiple searches into one query statement. For 
example, you might want to look for large-cap funds that appear in the top category 
quartile for the trailing three- and five-year periods.

Note the following when running a complex search:

• When combining the same Field Name in multiple consecutive rows (such as 
Morningstar Category in the screen shot below), use the OR relationship between 
those rows.

• Remember to use the Open and Closed Parentheses columns, marked by ( and ), to 
encapsulate the rows and help the system understand the order of operations when 
running the search.

When the Relationship  
between two rows is…

It means…

AND
Consecutive search criteria will be used together; that is,  
both must be true (X and Y).

OR Only one of the search criteria needs to be true (X or Y).

Repeat
The previous line will be copied, so you do not have re-
select a Field Name, Operator and Value, just change the 
Operator or Value.

Note the use of parentheses 
around rows conjoined 
with an OR relationship
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Finding Investments in the Research Module Saving a search
Saving a searchThe criteria you enter in the Advanced Search dialog box can be saved for easy retrieval 
in the future. Each user can save 100 searches.

 Note: When you save a search, you are saving only the criteria that comprise the search, and 
not the results of the search.

To save a search based on criteria you have entered, do the following:

1. From the Advanced Search dialog box where your criteria are entered, click Save. The 
Existing Searches dialog box appears.

2. Type in a name for the search; note that you are limited to 40 characters, including 
spaces and punctuation.

3. Click OK. The name of the search now appears in the title bar of the Advanced Search 
dialog box. You can also find the search on the Research Searches page in the left-hand 
navigation pane.

Type the name 
for a search here

You can access 
all of your saved 
searches in the 
Research module 
from this view
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Finding Investments in the Research Module Retrieving a saved search
Retrieving a saved 
search

You can retrieve the results of a saved search by clicking once on its name in the 
Research Searches view. This will immediately bring you to the correct universe, and 
the breadcrumb trail at the top of the screen will reflect the name of the search.

You can also retrieve the latest results of a search from within a data universe, such as 
the US Mutual Fund universe. Do the following:

1. In the upper-right corner of the screen, click the Saved Lists and Searches drop-down 
field.

2. Click once on the arrow to the left of the Advanced Search folder.
3. Click once on the name of the search whose results you want to see in the spreadsheet 

area. 

Click once on the name 
of a search to be brought 
to the results in the 
appropriate data universe

Select the name of 
the search you want 
to see from this list
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Modifying a saved 
search

You can review (and change, if needed) the criteria used to build a search by double-
clicking a saved search’s row in the Research Searches view. Be careful not to click on 
the hyperlink for a search’s name, as that will bring to the results for the search. 

You can also review the criteria for a search from anywhere in Advisor Workstation 2.0, 
by doing the following:

1. From the menu bar, select Tools…Advanced Search. The Advanced Search dialog box 
appears.

2. Click Open. The Open Existing Searches dialog box appears.
3. Click once to select the name of the search whose criteria you want to see.

4. Click OK. The criteria automatically appear in the Advanced Search dialog box.

Select a search from the list, 
then click OK to view 
the criteria that compose it
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Finding Investments in the Research Module Deleting a saved search
Deleting a saved searchBecause you are limited to saving 100 searches, you might occasionally need to delete 
one or more searches you no longer need, in order to enable you to save new searches. 

To delete a search, do the following:

1. Go to the Research Searches view (via the left-hand navigation pane).
2. Right-click on the name of the search you want to delete. A list of options appears.
3. Select Delete Selected Item(s) from the list of options. A new window appears.

4. Confirm the name(s) of the item(s) you want to delete, then click Yes. The item is now 
removed from the Research Searches view.

Right-click a search, then 
select Delete Selected Item(s)

Select the Research Searches view 
from the left-hand navigation pane
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Working with Lists in the Research Module

OverviewYou can save a set of investments as a list for later recall. This list is static (unlike a 
search, whose results are dynamic and could change each time you run it), and will not 
change unless you add items to or delete items from the list. Each user can save up to 
100 lists, and each list is limited to 500 items.

Saved lists can be seen in the Research Lists view, which is available from the left-hand 
navigation pane. Any item in a spreadsheet can be saved to a list. Therefore, you can 
actually save a list of lists. For instance, you could save all of your lists related to mutual 
funds or ETFs to its own list.

In this section, you will learn how to do the following with lists:

• Save a list
• Retrieve a list
• Add items to a list
• Delete items from a list, and
• Delete a saved list

Saving a list of 
investments

Before followin the steps below, be sure the items you want to save are displayed in 
the spreadsheet area. To save a list of investments, do the following:

1. In the spreadsheet area, highlight the items (up to 500) you want to save. You can click 
an investment’s row number to highlight a single investment, <SHIFT>+click to 
select multiple consecutive investments, or <CTRL>+click to select multiple non-
consecutive items.

2. From the menu bar, select File…New…List. The Save as List dialog box appears.

3. Type in a name for this list. The name cannot be more than 40 characters long.
4. Click Add All to move the items from the Total Search Results area to the Items selected 

for List area.
5. Click Save. A confirmation message appears.
6. Click OK to clear the confirmation message. 
7. Close the List dialog box.The list is now available from the Research Lists view.

Select this item 
from the menu
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Working with Lists in the Research Module Retrieving a list
Retrieving a listOnce a list is saved, there is only one way to display the list in the spreadsheet area. Do 
the following from the data universe where you want to see the list:

1. In the upper-right corner of the screen, click the Saved Lists and Searches drop-down 
field.

2. Click once on the arrow to the left of the Lists folder.
3. Click once on the name of the list you want to see in the spreadsheet area. The items in 

the list automatically appear in the spreadsheet area.

If you click on the Research Lists universe in the left-hand navigation pane, you can 
double-click the name of a list to see the items on the list (via the List dialog box). You 
can also add or remove items from the list in the List dialog box.

Select the name of 
the list you want 
to see from this list
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Working with Lists in the Research Module Adding items to a list
Adding items to a listOnce a list has been saved, you can add additional items to it, without having to 
retrieve, recreate and resave the entire list. To add to an existing list, do the following:

1. Navigate to the data universe where you will find the items to add to the list.
2. Run a search to isolate the item(s) you want to add to the list.
3. Click to select the item(s) in the spreadsheet area, so the rows are highlighted.
4. Right-click on one of the selected items.
5. From the right-click menu, select Add To Saved…List. The Lists dialog box appears.

6. Click once on the name of the list you want to add the item(s) to, then click Select. The 
List dialog box appears.

Right-click on a 
highlighted item, then 
select Add To Saved…List

Click once to choose 
the name of the list you
want to add the item(s) to
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Working with Lists in the Research Module Adding items to a list
7. The items you selected in the spreadsheet view appear in the Total Search Results area. 
To include all of the items in the list, click the Add All button.

 Remember, each list is limited to 100 items.

8. Click Save.

 You could also click Save As if you wanted to save the items as a new list, while preserving 
the original list.

9. Click the X in the upper-right corner of the dialog box to close it.

To include all items 
in the Search Results 
area in the list, click Add All
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Working with Lists in the Research Module Deleting items from a list
Deleting items from a 
list

You can delete selected items from a list, without having to delete the entire list and 
save a new one. To delete selected items from a list, do the following:

1. Go to the Research Lists universe (click on its name in the left-hand navigation pane)
2. Right-click on the list’s row(s) in the spreadsheet view.
3. From the right-click menu, select Delete Selected Item(s).
4. Click Yes at the confirmation message.

Deleting a listBecause you are limited to saving 100 lists, you might occasionally need to delete one 
or more lists you no longer need, in order to enable you to save new searches. 

To delete a search, do the following:

1. Go to the Research Lists view. (via the left-hand navigation pane.)
2. Right-click on the name of the list you want to delete. A list of options appears.
3. Select Delete Selected Item(s) from the list of options. A new window appears.

4. Confirm the name(s) of the item(s) you want to delete, then click Yes. The item is now 
removed from the Research Lists view.

Right-click a list, then 
select Delete Selected Item(s)

Select Research Lists from
the left-hand navigation pane
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Working with Custom Views in the Research Module

OverviewThe view you choose in Advisor Workstation’s Research module changes the columns 
you see in the spreadsheet area. A series of pre-defined views can be selected from 
the View drop-down field on the toolbar (the Basics view appears by default). 

 The data universe (Mutual Fund, Stock, ETF, etc.) you choose determines which views are 
available to you. 

In this section, you will learn how to do the following:

• Sort columns in a spreadsheet
• Resize columns in a spreadsheet
• Drag-and-drop columns into place in a spreadsheet
• Save a custom view after dragging and dropping
• Lock columns in place in a spreadsheet
• Create a custom view from scratch
• Set a custom view as the default view for a data universe, and
• Delete a custom view. 

Each user can create and save 100 custom views. Each custom view can contain up to 
100 columns.

Sorting columns in a 
spreadsheet

You can sort on any column in a spreadsheet view, but you can sort on only one column 
at a time. 

To sort a column, click once on its name. The spreadsheet will re-sort in ascending 
order. To re-sort the spreadsheet in descending order, click the column header once 
more.

The column header of the column sorting the spreadsheet is highlighted, and an arrow 
to the right of the column name indicates the sort order.

This view is being sorted 
by the Universe column, 
in ascending order
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Working with Custom Views in the Research Module Resize columns in a spreadsheet
Resize columns in a 
spreadsheet

You can change the width of any (or all) column(s) in a spreadsheet. Simply move your 
mouse cursor over the border between two columns, wait for the cursor to change to a 
double-headed arrow, then click and drag to the desired width.

The column width (as you change it) cannot be saved; it will reset as soon as you leave 
the module or reset the universe. 

Dragging-and-dropping 
columns into place  
in a spreadsheet

You can create a custom view on the fly by dragging-and-dropping columns into place. 
Simply left-click and hold on a column’s header, then drag it left or right until it appears 
in the location you want and release the left mouse button. 

After dragging-and-dropping columns into new locations, you must explicitly save such 
a view if you want to preserve it. Otherwise, as soon as you leave the view, conduct a 
search or reset the universe, it will automatically reset to its original form. 

Note how the cursor changes 
when you move over the border 
between two columns

Note the icons pointing 
to the new location for 
the Morningstar Rating 
column as it is dragged 
to the left and dropped
in a new location
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Working with Custom Views in the Research Module Saving a custom view after dragging-and-dropping columns
Saving a custom view 
after dragging-and-
dropping columns

Once you have dragged-and-dropped columns into place for a custom view, you can 
save it as a custom view. Do the following:

1. From the menu bar, select View…Save as Custom View. The Custom View dialog box 
appears.

2. In the Custom View Name field at the top of the dialog box, enter a name for the  
custom view. 

3. Click Save. 

4. Click Cancel to close the dialog box. After resetting the universe, you will be able to  
retrieve this custom view from the View drop-down list above the spreadsheet area.

Type a name for 
the custom view here
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Creating a custom view 
from scratch

The limitation of creating a custom view by dragging-and-dropping columns into place 
is that you can work only with the columns available in the view you are in. You can, 
however, also create a custom view by using any available data field from a universe. 
Each user can create up to 100 custom views, with up to 100 columns in each view.

To build a custom view using any column available in a data universe, do the following:

1. From the menu bar, select File…New…Custom View. The Custom View dialog box 
appears.

2. In the Custom View Name field at the top of the dialog box, enter a name for the  
custom view.

Select this option 
from the File menu

Type a name for 
the custom view here
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Working with Custom Views in the Research Module Creating a custom view from scratch
3. From the Select View drop-down field, choose the view whose columns you want to 
see. To see all data points available for a universe, select All Data Points at the top.

4. From the Available area, double-click the name of a field you want to include in your 
custom view.

5. Repeat steps 3-4 until all of the fields you want to include are present.
6. To change the order in which the fields appear in the Selected area, click once on a field 

and use the up and down arrows.

 The order in which the fields appear from top-to-bottom are the order they will appear from 
left-to- right in the custom view.

7. Click Save.
8. Click Cancel to close the dialog box. After resetting the universe, you will be able to  

retrieve this custom view from the View drop-down list above the spreadsheet area.

Select the name of 
the view whose data 
points you want to 
see from this list

After selecting a field, 
use these arrows to 
change a field’s position 
in the custom view
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Setting a custom view 
as the default view

You can use a custom view as the default view for a universe. Once you set a new 
default view, that view will appear each time you visit the universe, rather than the 
system-defined default view, such as the Basics view in the US Mutual Fund universe.

 You can also use any other system-defined view as the default view for a universe, using the 
instructions below.

1. Make sure you are in the data universe where you will set the default view.
2. From the View drop-down menu above the spreadsheet area, select the name of the 

view you want to use as the default view.
3. From the View menu at the top of the screen, select Set as Default View. The current 

view will now be used as the default view each time you visit the data universe.

Be sure to select the 
name of the view you 
want to use as the default view 

Select this option 
from the View menu
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Working with Custom Views in the Research Module Deleting a custom view
Deleting a custom viewBecause you are limited to saving 100 custom views, you might occasionally need to 
delete one or more custom views you no longer use or need. 

To delete a custom view, do the following:

1. Go to the Research Custom Views universe (via the left-hand navigation pane).
2. Right-click on the name of the custom view you want to delete. A list of options 

appears.
3. Select Delete Selected Item(s) from the list of options. A new window appears.

4. Confirm the name(s) of the item(s) you want to delete, then click Yes. The item is now 
removed from the Research Custom Views view.

Right-click on the custom 
view you want to delete, 
then select this option

Select this universe to 
delete a custom view
Version 2.0 35



Generating Graphs Overview
Generating Graphs

OverviewThis section covers the graphs available in Advisor Workstation. You can generate 
graphs from any location in Advisor Workstation from the Tools menu; you do not need 
to be in the Research module in order to generate a graph. Still, it can be most useful to 
begin in the Research module, since you can retrieve a list (or search) and select the 
items you want to have appear before you generate the graphs. 

Also, note that you do not need to select a particular graph to appear. All graphs appear 
in a new window, and you can select which graph you want to see by selecting its tab.

You will learn the following in this section:

• What graphs are available
• What features are common to all graphs
• What each graph shows, and
• How to generate graphs.

What graphs are 
available?

The following graphs are available in Advisor Workstation:

• Rolling Return
• Correlation Matrix
• Risk/Reward Scatterplot
• Investment Growth
• Total Annual Return
• Premium Discount (used only with ETFs and Closed-End Funds)
• Return vs. Category Quartiles

How to generate a 
graph

To generate a graph, do the following:

1. In the spreadsheet area, click the row numbers to highlight the investments you want 
included on the graph. You can click one item, or <SHIFT>+click to select multiple 
consecutive items, or <CTRL>+click to select multiple non-consecutive items.

2. From the menu bar, select Tools, then Graphs. The Graphs window appears.
3. Select the tab for the graph you want to see.
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What features are 
common to all graphs?

Certain elements are common to all graphs. These features allow you to manipulate or 
update the graphs, without having to leave the graph window. These features are 
explained in the following table.

Feature Description

Time Period

The Time Period buttons (3 years, 5 years, etc.) allow you to 
select a different trailing time period for a graph. Keep in mind 
that if a security lacks sufficient history, it will not appear when 
you change to a longer time period.

Report

The Report icon allows you to generate a PDF version of the 
graph. Some PDF graph reports have been reviewed by FINRA 
for client use, while others have not. Check the header area of 
each report to see whether this is appropriate. Also, adding 
certain elements to a graph, such as an index or proxy, can 
trigger the header warning.

Draw

The Draw icon needs to be clicked each time you change an 
element of a graph – adding or removing a security, changing 
the time period or benchmark, etc. It’s only after you click the 
Draw icon that you will see the updated graph.

Securities panel

This panel shows you which investments are available to be 
displayed in the graph. If the graph limits the number of 
securities that can be shown, the items at the top of the panel 
will be selected first by default. You can choose to add 
securities from here, and you can hide this panel as well.

1 2 3

4

1 - Use these icons to change the time period for a graph
2 - Click this icon to generate a PDF version of a graph
3 - Click the Draw icon any time you make a change to a graph
4 - Use the elements in this area to hide the securities, choose different securities, 
    select or deselect all securities, or select or deselect individual securities
Version 2.0 37



Generating Graphs What does the Rolling Return graph show?
What does the Rolling 
Return graph show?

The Rolling Returns graph shows you the monthly returns of a security over a rolling 
period of time. Only one security can be displayed at a time in the graph.

Positive returns are displayed as green bars, while negative returns are red bars. You 
can also elect to highlight both the highest and lowest returns within a set.

The following rolling time periods are available:

• 3 months
• 6 months
• 12 months
• 36 months
• 60 months, and 
• 120 months. 

You can also select the time period you want to cover in the graph. The default options 
are for a 3-month rolling return covering the trailing one-year period. If you elect to 
change either the rolling time period or the date range being graphed, you’ll need to 
click the Draw icon above the graph to reflect the changes .

1 2

3

4

1 - Select the rolling return interval from this drop-down field
2 - Click the check box to see the highest and lowest returns during the period being graphed
3 - Choose the time period to display
4 - If you move your mouse over a bar, a tooltip appears to show you the return for that month
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Generating Graphs What does the Correlation Matrix graph show?
What does the 
Correlation Matrix 
graph show?

The Correlation Matrix shows you the similarity of returns among a group of 
investments over a certain time period. You must include at least two securities, and 
can include up to 20. 

The scale of correlation ranges from -1.0, which indicates that securities moved in the 
opposite direction, and 1.0, which means securities moved in the same direction over 
the time period being displayed.

The default time period in the Correlation Matrix is the trailing three-year period, but 
you can change this to either the trailing five-year or 10-year period.

1

1 - Note the color-coded key showing the different ranges of correlation

2

2 - If you change the Time Period, or add or remove items, 
     be sure to click the Draw icon to reflect those changes in the graph
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Generating Graphs What does the Risk/Reward Scatterplot graph show?
What does the Risk/
Reward Scatterplot 
graph show?

The Risk/Reward Scatterplot allows you to select up to 99 securities at once, to 
compare performance and risk (standard deviation) over a certain time period. The 
default time period is the trailing three-year period, but you can change this to either 
the trailing five-year or 10-year period.

On the Scatterplot, dots appearing higher have performed better than lower dots, and 
those appearing to the left have had experienced less volatility than those appearing to 
the right. 

If you move your mouse over a dot, you can see the following information:

• the name of the investment
• the standard deviation, and
• the return.

1 2 3

4

1 - Click the checkbox to include a benchmark
2 - Click the Select button to choose a benchmark
3 - Click Draw after selecting a benchmark
4 - A pop-up window appears when you move your mouse over a dot
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Generating Graphs What does the Risk/Reward Scatterplot graph show?
You can include a benchmark on the Risk/Reward Scatterplot as well. To include a 
benchmark, do the following:

1. Click the Include benchmark box above the Scatterplot area.
2. Click the Select button to the right of the Include benchmark box. The Find/Add 

Benchmark dialog box appears.
3. In the search field, type the name of the benchmark you want to find. 

 The intelligent search agent automatically suggests results as you type. If you see the 
benchmark you want to use, click once on its name to automatically move it to the 
Investments Selected area. To use the S&P 500 index as the benchmark, type S&P 500 TR.

4. If needed, click Find to search for the benchmark you want to use. Click once to select 
its name in the the Total Search Results area, then click Add.

5. Click OK to close the dialog box.
6. Click the Draw button above the Scatterplot area to apply the benchmark.

As you type a name, 
the system suggests 
matching benchmarks

Be sure the benchmark 
you want to use appears here
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What does the 
Investment Growth 
graph show?

The Investment Growth graph, by default, shows the growth of $10,000 from the 
earliest common time period for the selected investments. You can select up to 10 
investments at once. You can change the investments that appear on the graph, the 
time period being reflected, and the initial investment amount. The returns shown are 
net of fees and expenses (except for Separate Accounts).

If you move your mouse over a line in the graph, a pop-up message appears showing 
you the investment value as of the date at that point in the graph’s timeline, and the 
cumulative return percentage as well. You can also elect to show annualized returns on 
the graph by using the checkbox on the toolbar above the graph.
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What does the Total 
Annual Return graph 
show?

The Total Annual Return graph shows you the annual return for up to 10 securities. You 
can see both the annual return for the previous calendar year, as well as year-to-date 
returns for the current year (through the prior month-end period). You can also elect to 
see annual returns for the 3-, 5- or 10-year periods.

If you move your mouse over a bar in the graph, a pop-up message appears, showing 
you the total return for an investment for that year.
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What does the Premium 
Discount graph show?

The Premium Discount graph applies only to ETFs and Closed-End funds, and you can 
display only one security at a time. The default time period is for the trailing one-year 
period. Other time periods are available, or you can elect to see values from the earleist 
avaialble time, or a custom date range. Monthly results are always shown. You can also 
elect to see the highest premium and lowest discount for the time period you are 
displaying. 
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What does the Return 
vs. Category Quartiles 
graph show?

The Return vs. Category Quartiles graph allows you to compare an investment’s return 
to its Morningstar category, as well as to a primary and secondary benchmark. You can 
display only one investment at a time, and it must be a managed product. (The graph 
will not work with individual stocks.)

By default, returns for each of the trailing three years is shown (along with YTD 
information), but you can elect to see returns for the trailing 5- or 10-year periods as 
well.

For each year in the graph, you will see a stacked bar chart with four different colored 
sections. The top quartile for each category is green, the next quartile is yellow, the 
third quartile is light blue, and the lowest quartile is dark blue. The height of each 
section indicates the range of returns for that quartile. 

Next to each stacked bar chart is a set of triangles. The red triangle to the left of the bar 
chart is the fund itself; take note of which quartile it points to. This is where the fund 
ended the year. To the right of the bar chart are two triangles. The white arrow 
represents the primary benchmark, while the green triangle represents the secondary 
benchmark. Where does the triangle for the fund appear compared to the triangles for 
the benchmarks? Did it outperform or underperform one or both benchmarks?

Note the following additional points about this graph:

• It is not possible to change the primary or secondary benchmarks; these are assigned 
automatically to each investment. 

• If you move your mouse over one of the stacked bar charts, you will see a pop-up 
message that shows you the return of the fund, as well as the high and low returns for 
the category.
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Creating Reports from the Research Module

OverviewThis section explains how to create reports from the Research Module. Note that you 
do not need to be in the Research Module to create reports for securities. The following 
options are also available:

• You can generate a Morningstar Quicktake or an Investment Detail Report (IDR) from 
the Security Finder widget on the Home Page. 

• You can activate the Security Report Builder from the Tools menu when you are in any 
screen or module in Advisor Workstation. 

• When looking at the holdings for a portfolio in the Clients & Portfolios module, you can 
right-click on the holdings to create any security report.
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What reports are 
available for securities?

You can produce the following reports for securities:

• a Current View report, which gives you a PDF output of what you have selected in the 
spreadsheet view at the time you run the report

• an Investment Detail Report which has been reviewed by FINRA and is available as a 
PDF

• an HTML Morningstar report (also known as the Quicktake report) with more 
subjective information about an investment, including an editorial analysis (if available). 
The Quicktake report has not been reviewed by FINRA for use with clients.

• an Underlying Holdings report (for managed investments), which shows you the 
securities owned by a fund.  

• a Price and Distribution report which provides historical price and distribution data 

See the table below for information about each report.

Report Comments

Current View 

PDF report that replicates the spreadsheet view. Note the following 
about this report:

• You must highlight the investments you want to see on the 
report before running the report

• Be sure to select the correct view before running the report
• If the view contains more than 11-12 columns, it is likely that the 

data will spill over onto secondary pages in the report, which can 
make it harder to read’

• Using a custom view with fewer than 12 columns with this 
report is usually recommended, to ensure all of the data appears 
on one page for an investment

Investment Detail

PDF report that is usually NASD compliant. Check both the report’s 
header, and with your compliance department before leaving this 
report with a client. 

This report contains the following main sections:

• Performance
• Portfolio Analysis
• Fees and Expenses
• Risk and Return Profile, and
• Operations

Morningstar (Quicktake)

HTML report with multi-tab interface. This report is not NASD 
compliant. Note the following about this report:

• If you run this report for multiple investments, a drop-down field 
is available in the upper left part of the screen to toggle to a 
different investment.

• The Ownership Zone graph is available from the Portfolio tab
• You can use the Actions menu (just above the tabs) to view the 

data dictionary for the report, generate an Investment Detail 
report for the investment selected, or print the HTML report. 

Price and Distribution 

PDF report that is usually NASD compliant. Check both the report’s 
header, and with your compliance department before leaving this 
report with a client. 

This report contains the following main sections:

• Historical change in NAV
• Historical income and capital gain data
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Tips and Tricks for the Research Module

OverviewThis section will review a number of other tools available to you in the Research module 
that have not been covered elsewhere. You will learn the following:

• How to interpret Morningstar’s Equity Style Box
• How the Morningstar Category is assigned, and
• What the Ownership Zone can tell you about a fund’s investments.

Interpreting 
Morningstar’s Equity 
Style Box 

Morningstar updated its style box methodology in 2002, to more accurately determine 
a mutual fund’s true investment style.

Note the following about the Equity Style Box:

1. It is an entirely holdings-based calculation derived from a fund’s reported holdings. 
Although the SEC requires funds to report their holdings annually, nearly 90% do so on a 
quarterly basis.

2. A fund’s location in the Equity Style Box is based on a uniform calculation across all 
stocks. Ten data fields are used: five for value, and five for growth.

3. Stocks are broken into three market-cap groups, as shown in the table below.

4. Each stock is scored across all 10 factors and ranked on Value, Blend and Growth 
characteristics, versus their own market cap group.

5. Attributes for mutual funds are asset-weighted to determine its place in the Equity Style 
Box.

6. The international stocks tracked by Morningstar (approximately 800) are also included in 
this calculation.

Market Cap Size Description

Large Cap
Represent about 70% of US market capitalization; 
approximately the top 260 companies.

Mid Cap
Represent the next 20% of companies, around the next 
800 companies.

Small Cap
Represent the remaining 10% of companies, 
approximately the bottom 5000 companies.
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Understanding 
Morningstar’s Mutual 
Fund Categories

The Morningstar Category is the primary classification for a fund among its peers. It 
helps determine the risk-adjusted star rating a fund receives. 

For domestic equity funds, the Morningstar Category is determined by averaging the 
trailing 36 months of Equity Style Box values. This could cause a fund to switch both 
Category and Style Box representation. For example, a fund could be in the Large 
Growth category, but have a style box of Mid Growth.

Interpreting 
Morningstar’s 
Ownership Zone

The Equity Style Box can cause a mutual fund to appear more style specific than it 
really is. Due to this, Morningstar developed the Ownership Zone, which can also be 
used to identify style drift. The Ownership Zone is found in the Morningstar Report (also 
known as the Quick Take report), and illustrates the top 75% of a fund’s underlying 
holdings, including the fund’s centroid.

In the example above, the fund selected has a Morningstar Category of Mid-Cap Value. 
However, the Ownership Zone shows that the centroid is actually in the Large-Cap 
Value zone, and that a great number of other holdings are also in the Large-Cap zone. 

In addition, if you examine the Investment Style History in the lower right corner of the 
screen shot, you can see that this fund has gone from being classified as a Mid-Cap 
Value fund in 2001-2004 to a Large-Cap Value fund in 2005. So, if you bought this fund 
in 2002 as a Mid-Cap Value holding for a client, you might want to reconsider whether 
it is still playing the role you intended for that portfolio.

Note the change to the fund’s
Investment Style History here.
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